
(IMP-44) Users upload accomplishments (user side) 
 

Users have the ability to add, edit and delete external learning events to their history page. The user 

can upload files as supporting documentation for these external learning events, called 

Accomplishments. Users can filter their history page by their Learning Activities and 

Accomplishments.   

 

Users uploading and managing Accomplishments takes place in:  

- History Page (user) 

Managing Accomplishment labels, and bulk uploading takes place in:  

- Configuration Page (admin) 

Enabling/Disabling Accomplishment feature is handled in:  

- Client Level (ePath)   

 

The user story of how Accomplishments are handled in History Page is detailed below:  

HISTORY PAGE (User)    
1) Activity Details Order on Page  

1.1) Learning Activities: left column 

1.2) Learning Activities: middle column 

1.3 Accomplishments: left column 

2) Filter Menu 

2.1) Filter Menu Selections:  

  2.1.1) All, All 

2.1.2) LA, All 

2.1.3) Accomplishments  

2.1.4) All, Not Started  

2.1.5) All, In Progress 

2.1.6) All, Completed 

2.1.7) All, Accessible After Completion  

2.2) List View (Hidden)  

3) Sort Menu 

4) Adding Accomplishments  

5) Editing Accomplishments  

6) Deleting Accomplishments  

7) Viewing Attachment(s) on Accomplishments  



1) Activity Details Order on Page 

1.1) Learning Activities: left column 

- Learning Activity Name (if title is blue-colored, it indicates that LA is accessible after completion) 

- Learning Activity Original Title (if the LA name has been changed previously) 

- Learning Activity File Type (e.g. Image, Document, SCORM 1.2 WBT…)  

- Version (Appears if enabled)  

- Due Date (Red-colored Due Date is meant to alert the user to complete the LA before it’s due. If it’s 

an ILT, Event Info replaces the Due Date, and Event Info should also be red-colored. If the user has 

selected no events yet, ‘No events selected have been added to event yet’ is added (also in red). If 

Location title includes Event Info in it, it should appear in red. In short; any LA due date, or any 

selected or unselected event info should be displayed in red. Due Date title shouldn’t appear unless the 

LA has a Due Date.) 

 

1.2) Learning Activities: middle column 

- LA Status (There are four states: ‘Not Started’, ‘In Progress’, ‘Completed’, ‘Pending Approval’) 

- Completion Date and Time (if LA is completed) / Last Activity Date and Time (if LA is in progress) 

- Registration Type (There are three types: ‘Required’, ‘Recommended’, or ‘Self Registered’. 

Required is the only red-colored LA, and meant to alert the user to complete the LA before it’s due) 

Example (1.1 and 1.2 together) :  

Artificial Intelligence Basics    Completed on 2018-10-08 11:00 AM EDT 

Learning Activity Type: Document   Required 

Due Date: 08/12/2016 

 

1.3) Accomplishments: left column 

- Accomplishment Name (All are blue-colored, as they are accessible whenever clicked on) 

- Accomplishment Type (User chooses the type from the dropdown-list while creating it) 

- Completion Date (User enters the completion date of their Accomplishment) 

- Location (It’s optional. It shouldn’t appear unless the user enters a location) 

- Description (It’s optional. It shouldn’t appear unless the user enters a description) 

 

Example (1.3):  

MBA Diploma 

Type: Job Requirement 

Completion Date: 08/22/2014 

Location: San Francisco, CA 

 



 

2) Filter Menu:  

(Existing filter menu has ‘Learning Activity Type’ and ‘List View’ dropdown menus.)  

In the new design, there are three dropdown menus: ‘Activity Type’, ‘Status’, and ‘List View’. 

‘Learning Activity Type’ dropdown menu is removed. Two new dropdown menus (‘Activity Type’ 

and ‘Status’) are added. ‘List View’ dropdown menu is maintained. 

 

The filter menu enables viewing Learning Activities and Accomplishments separately. The user may 

also filter their LAs by their progress status (not started, in progress, completed) and their accessibility 

(‘Accessible After Completion’). Default setting for filter feature is (Activity Type: All, Status: All, 

List View: My View).  

 

Filter menu features in detail:  

- Activity Type 

 - All: no filters (default) 

- Learning Activities  

 - Accomplishments  

- Status  

- All: no filters (default) 

- Not Started  

- In Progress 

- Completed 

- Accessible After Completion  

- List View (existing feature) 

 - My View (default) 

 - Hidden  

 

2.1) Filter Menu Selections  

Below are selection alternatives and how they are displayed to the user: 

 

2.1.1) Activity Type: All / Status: All  

All LAs (that the user is registered to) and all Accomplishments (the user uploaded) are displayed, 

except Hidden LAs. If a user wants to restore a hidden LA file, they should go to My View>Hidden, 

and select the LAs they wish to restore. Accomplishments cannot be hidden or restored; they can 

either be uploaded by the user or deleted.  

 



Order of content sorted by date:  

- LAs and Accomplishments are sorted altogether by most recent first.  

- If due date is still in the future, LAs are sorted by due date with the closest due date first.  

- If due date passed, completed LAs are sorted by completion date starting with the nearest date. 

- If due date passed, not completed (‘not started’ or ‘in progress’) LAs are sorted by nearest due date.  

- Accomplishments appear by completion date, most recent first.  

- LAs with no due date appear in this order: Required LAs alphabetically first, Recommended LAs 

alphabetically next, Self-Registered LAs alphabetically last  

 

Example:  

A) Required LA ‘not started’ with due date next month (by due date) 

B) Required LA with due date Dec 1, 2018 that was ‘completed’ on Aug 1, 2018 (by completion date) 

C) Required LA ‘not completed’ that was due on Oct 1, 2018 (by due date) 

D) Accomplishment with a completion date of Nov 1, 2018 (by completion date)  

F) Required LA named Alpha with no due date (by priority)  

E) Recommended LA named Beta with no due date (by priority) 

 

Order should be: A, C, D, B, F, E  

A is the most important, it’s not completed and due date is still in the future.  

B is completed, sorted by completion date, as completion date is more relevant that due date here 

C is not completed, due date has passed, due date is more relevant to the user search 

D is an accomplishment, there is only one date that counts: completion date  

F is a required LA with no due date; appears before E because required (F) has more priority  

E is a recommended LA with no due date; appears after F because recommended (E) has less priority 

 

2.1.2) Activity Type: Learning Activities / Status: All 

All LAs that the user is registered to are displayed (except hidden files).   

Order of content sorted by date:  

If the due date is still in the future, LAs are sorted by due date.  

If the due date has passed, completed LAs are sorted by completion date. 

If the due date has passed, not completed (‘not started’ or ‘in progress’) LAs are sorted by due date.  

LAs with no due date appear in priority order.  

 

2.1.3) Activity Type: Accomplishments 

All Accomplishments the user uploaded to their history are displayed.  

All Accomplishments are considered ‘complete’; therefore ‘Status’ dropdown menu disappears.  



No Accomplishment may be hidden, only deleted, so ‘List View’ dropdown menu disappears. 

 

Order of content sorted by date:  

Accomplishments are sorted by their completion date in this order:  

1) Accomplishments with ‘Job Requirement’ type, starting with the most recently completed 

2) Accomplishments with ‘Professional Development’ type, starting the with most recently completed  

3) Accomplishments with ‘Volunteer Work’ type, starting with the most recently completed 

3) Accomplishments with ‘Personal Interest’ type, starting with the most recently completed 

 

Accomplishments belong to a group determined by their Accomplishment Type, and sorted by their 

completion date inside each type, most recent first (Type names and rank order are handled on the 

Configuration Page)  

 

Default type labels in the system are: “Job Requirement’, ‘Professional Development’, ‘Volunteer 

Work’ and ‘Personal Interest’ and follow this priority order on the page (Admin may edit/add/these 

these labels in the Configuration page). 

 

If Admin decides to remove all Accomplishment types in the Configuration Page settings, users’ 

Accomplishments will be displayed sorted by their completion date, regardless of their level of 

importance.  

 

2.1.4) Activity Type: All / Status: Not Started 

All LAs that the user is registered to but haven’t started (launched) are displayed. If a LA has a due 

date, and has not been started before the deadline, it’s also listed under here. 

Status dropdown menu applies to Learning Activities only, and when a Status option other than ‘All’ 

is used as a filter, Accomplishments are excluded.  

Order of content sorted by date:  

No accomplishments are displayed, because Status feature is active for Learning Activities only.  

All LAs are sorted by due date. LAs with no due date appear in priority order.  

 

2.1.5) Activity Type: All / Status: In Progress 

All LAs that the user started but not completed are displayed, regardless of their deadline. LAs that 

have not been completed on time (past deadline) are also displayed under ‘in progress’ although their 

due date has passed.  

Order of content sorted by date:  

No accomplishments are displayed, because Status feature is active for Learning Activities only.  



All LAs are sorted by due date. LAs with no due date appear in priority order.  

 

2.1.5) Activity Type: All / Status: Completed 

All LAs that the user completed are displayed. If a LA has a due date, and completed before the 

deadline, it’s listed under here.  

Order of content sorted by date:  

No accomplishments are displayed, because Status feature is active for Learning Activities only.  

All LAs are sorted by completion date, including LAs with no due date.  

 

2.1.6) Activity Type: All / Status: Accessible After Completion 

All LAs -with enabled access after completion- that the user completed are displayed. If a LA has a 

due date, and completed before the deadline, it’s listed under this filter.   

Order of content sorted by date:  

No accomplishments are displayed, because Status feature is active for Learning Activities only.  

All LAs are sorted by completion date, including LAs with no due date.  

 

2.1.7) List View: Hidden  

The user may hide their recommended or self-registered LAs by using the List View filter feature.  

The user may filter their list as My View or Hidden. 

- My View filter displays the user’s history page; it’s the default selection.  

- Hidden filter displays the LAs that the user hid from their history (My View) page.  

How user hides a LA: User clicks on the (x) button on the right side of that LA.  

How user views a hidden LA: User may use filter feature (Filter>List View> Hidden) 

How user restores a LA: In Hidden page, user clicks on the (Restore) button next to that LA 

- Hide feature does not apply to Required LAs; thus x (hide) button is not included for Required LAs.  

 

3) Sort Menu:  

(Existing sort menu has ‘Most Recently Updated’ and ‘Alphabetical’ options.)  

In the new design, ‘Most Recently Updated’ option is removed. ‘Date’ option is added.  

‘Alphabetical’ option is maintained. 

Sort feature helps users to sort their LAs and Accomplishments by date or alphabetically.  

Default setting for sort feature is by date.  

Sort by date: Explained in detail in the previous section. 

Sort alphabetically: Activities are sorted in ascending alphabetical order. 

 

 



4) Adding Accomplishments:  

User may add any Accomplishment to their History page by using ellipsis (three-dot) menu.   

User adding an accomplishment, in steps:  

- User clicks on the ellipsis menu on the upper right side of the page, clicks on ‘Add Accomplishment’  

- A new page named ‘Add Accomplishment’ opens. User fills out the details of the accomplishment 

they wish to enter. User is required to fill ‘Name’, ‘Date Completed’ and ‘Type’ fields.  Filling out 

‘Description’, ‘Location’ fields, and uploading document(s) are optional.  

- ‘Type’ is a dropdown menu that includes four different categories for labeling the Accomplishment 

type: ‘Job Requirement’, ‘Professional Development’, ‘Volunteer Work’, and ‘Personal Interest’. The 

client may customize these labels according to their needs. Admin may edit/delete these labels or add 

new labels under Accomplishments icon in the Configuration Page.  

- The user may delete any file they uploaded by clicking on the delete button placed next to that 

attachment.  

- User clicks ‘Save’ button after completing the Accomplishment information. 

- Clicking ‘Save’ takes the user back to their history page.    

- Clicking ‘Cancel’ button takes the user back to their history page without saving anything.  

 

5) Editing Accomplishments:   

User may edit any Accomplishment on the History page by clicking on that Accomplishment name.  

User editing an accomplishment, in steps:  

- User clicks on the Accomplishment name. 

- A page named ‘Edit Accomplishment’ opens, same as ‘Add Accomplishment’ page except its title. 

When an accomplishment is created, the header on this page is  ‘Add Accomplishment’; the next time 

the user clicks on the Accomplishment they created, the header changes to ‘Edit Accomplishment’.  

- User may edit any detail of the accomplishment they created. The user may delete any file they 

uploaded by clicking on the delete button placed right next to that attachment. 

- User clicks ‘Save’ button after completing the Accomplishment information. 

- Clicking ‘Save’ takes the user back to their history page.    

- Clicking ‘Cancel’ button takes the user back to their history page without saving anything.  

 

6) Deleting Accomplishments:  

User may delete any Accomplishment on the History page by using the trash can icon placed on the 

far right side of each Accomplishment name.  

User deleting an accomplishment, in steps:  

- Admin clicks on ‘Delete’ button (Clicking ‘Cancel’ will revert the page back to last saved settings) 



- Clicking ‘Delete’ button opens a dialog box that appears in the middle of the screen with Cancel and 

OK options, blurring out the rest of the background and restricting the user to make a decision on their 

action. On the notification box, it says: “You are about to delete this Accomplishment. Do you wish to 

proceed?” 

- Clicking Cancel closes the dialog box.  

- Clicking Yes executes the command and the user returns to the page they deleted their 

Accomplishment from on their History page.   

 

7) Viewing Attachment(s) on Accomplishments:   

User may view an attachment of any Accomplishment on the History page by using the attachment 

name placed on the right side of each Accomplishment name.  

User may upload as many attachments they want. These attachments will appear on the page in the 

upload order right below one another, one attachment per line. If the number of attachments exceeds 

the size of a row, the row will expand.  

 

CONFIGURATION PAGE (Admin) 

In addition to the (History Page) user story, a brief summary of Configuration Page features:  

Admin has the ability to change settings for external learning events (a.k.a. Accomplishments).  

- Admin may add/edit/delete labels for Accomplishment types.  

The default labels for the Accomplishment types are: ‘Job Requirement’, ‘Professional Development’, 

‘Volunteer Work’, and ‘Personal Interest’. The admin may customize these labels according to their 

needs; edit existing labels, delete them, or add new ones.  

- Admin may bulk upload Accomplishments using the ellipsis menu (Import Accomplishments)  

Admin may change the order of any label by moving it up on the Configuration page label list.  

 

Admin prioritizing a label over other labels:  

- Admin selects an Accomplishment label (e.g. ‘Education’ is the label) by checking Select Box. 

- Actions menu appear. Admin clicks on the Actions menu with several options.  

- Admin clicks on ‘Move Up’ option. The selected label moves up one row. Admin continues to repeat 

the action until the selected label is moved up to the top of the labels.  

 

Admin enabling/disabling Accomplishments feature in a portal:  

- Admin may enable/disable a portal’s accomplishments feature in its entirety in the Configuration 

Page under Portal Settings, by checking/unchecking Accomplishments feature. By default, this feature 

is enabled. 


